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ABSTRACT 
 

 Coal is an extremely important fossil fuel for energy production throughout the United 

States and the world. However, burning coal and other fossil fuels is known to emit harmful 

greenhouse gases such as carbon dioxide (CO2) into the atmosphere. Carbon capture and storage 

(CCS) is a leading method for reducing CO2 emissions during energy production, but many 

current commercial CO2 capturing technologies are energy and cost intensive. Chemical-looping 

combustion (CLC) is a suggested method for producing a sequestration-ready CO2 stream from 

the combustion of fossil fuels by using a metal oxide to transport oxygen from the air to the fuel. 

CLC is a highly researched topic with numerous proposed fuels, metal oxides, and reactor 

designs. Previous studies have shown that with an externally heated reactor, the combustion of a 

solid fuel with copper oxide can occur through oxygen uncoupling and solid-solid reaction 

mechanisms. However, if a hot-spot is produced in a packed mixture of carbon fuel and copper 

oxide, the reaction may combust rapidly and become self-propagating.  

 The goal of this study is to test this self-propagating reaction in order to better understand 

the combustion reaction of solid carbon fuel with copper oxide and to evaluate it as a feasible 

approach to CLC. The carbon fuel – copper oxide combustion reaction is modeled in a quartz 

tube under an initial preheat temperature with a laser igniting the reaction and the resulting flame 

propagation captured on a high-speed camera. The preheat temperature is varied in order to 

understand the impact of reactant initial temperature on flame propagation and intensity. A 

higher preheat temperature is shown to increase the flame front coherence and propagation 

speed. Multiple particle sizes are also tested, with the larger particle sizes producing significantly 

slower propagations and less coherent flame fronts. Two oxidation states of copper oxide are 

experimented with to observe the behavior exhibited by different stages of the reaction.  
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Chapter 1 Introduction 

1.1 Motivation 

Coal is an extremely important fossil fuel for energy production throughout the United 

States and the world. However, burning coal and other fossil fuels is known to have adverse 

effects on the environment, most notably the emission of greenhouse gases into the atmosphere. 

Carbon dioxide (CO2) is the primary man-made greenhouse gas emitted into the atmosphere 

through energy production and is a main culprit of climate changes. While alternative energy 

sources such as wind and solar are gaining popularity to reduce CO2 emissions, the majority of 

the world remains dependent on fossil fuels for energy generation [1]. Thus, it is highly desirable 

to develop methods of effectively mitigating or eliminating CO2 emissions in fossil fuel 

combustion. 

Among these mitigation efforts, carbon capture and storage (CCS) remains a key 

technology. CCS is a post-combustion process that reduces emissions by removing CO2 from the 

combustion product stream before entering the atmosphere and storing the CO2 where it will not 

be released. However, the CCS process is complicated by the need to separate CO2 from other 

gases that are present in the fuel-air combustion product stream, mainly N2 and NOx gases [2]. A 

basic conventional combustion process consists of a carbon-based fuel reacting with heat and air 

to form carbon dioxide, nitrogen gas, water vapor, and energy in the form of heat, as shown by 

equation (1).  
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 𝐻𝐻𝐻𝐻𝐻𝐻𝐻𝐻 + 𝐶𝐶𝑛𝑛𝐻𝐻𝑚𝑚 + 𝐴𝐴𝐴𝐴𝐴𝐴(𝑁𝑁2,𝑂𝑂2) → 𝐶𝐶𝐶𝐶2 + 𝐻𝐻20 + 𝑁𝑁2 + 𝐻𝐻𝐻𝐻𝐻𝐻𝐻𝐻 (1) 

For the CO2 to be captured and stored, it must first be “scrubbed” away from the other products 

in the stream, the most difficult to scrub being nitrogen. This complication causes the carbon 

capture process to be energy and cost intensive [2]. One method of extracting the carbon dioxide 

for CCS is by combusting fuels with pure oxygen rather than air, creating a flue gas consisting 

primarily of carbon dioxide and water vapor. With only H2O and CO2 in the product stream, the 

H2O can easily be condensed out, leaving a sequestration-ready CO2 not diluted by N2. By 

combusting fuels with pure oxygen, CO2 can be separated without the need to extract other gases 

present during traditional combustion with air.  

1.2 Introduction to Chemical-Looping Combustion 

A conventional oxy-fuel combustion process would require the use of cryogenic air 

separation to extract pure oxygen. The cryogenic air separation process consumes an appreciable 

amount of energy, making a conventional oxy-fuel combustion process energy and cost 

intensive. One alternative method of achieving an oxy-fuel combustion is through chemical-

looping combustion (CLC). The CLC process utilizes a solid metal oxide as an oxygen carrier to 

supply oxygen for the conversion of fuel, similar to the role of hemoglobin within the 

bloodstream. When a gaseous or solid carbon-based fuel is combusted with the metal oxide, the 

products stream consists of CO2, H2O, and a reduced solid metal, as shown by reaction (2). The 

reduced metal is then re-oxidized with air in an external oxidation reactor through reaction (3), 

resulting in depleted air and regeneration of the metal oxide.   
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 𝐶𝐶𝑛𝑛𝐻𝐻𝑚𝑚 + 𝑀𝑀𝑀𝑀𝑥𝑥𝑂𝑂𝑦𝑦  → 𝐶𝐶𝐶𝐶2 + 𝐻𝐻20 + 𝑀𝑀𝑀𝑀𝑥𝑥𝑂𝑂𝑦𝑦−1 (2) 

 𝑀𝑀𝑀𝑀𝑥𝑥𝑂𝑂𝑦𝑦−1 + 𝐴𝐴𝐴𝐴𝐴𝐴 (𝑁𝑁2,𝑂𝑂2) →  𝑀𝑀𝑀𝑀𝑥𝑥𝑂𝑂𝑦𝑦 +  𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷 𝐴𝐴𝐴𝐴𝐴𝐴 (𝑁𝑁2,𝑂𝑂2)   (3) 

The loop is completed when the oxidizer is recirculated into the fuel reactor and is once again 

combusted with fuel. With the solid reduced metal extracted, the gaseous fuel reactor product 

stream consists of carbon dioxide and water vaper, with H2O easily condensed out, leaving a 

pure stream of CO2. The fuel reactor products stream is isolated from the air reactor, preventing 

the N2 and other gases within the air from contaminating the CO2 stream or the combustion 

process. Some of the exhaust gases may also be recirculated to regulate the reactor temperature. 

The overall CLC process is shown graphically by figure 1 with a general metal oxide, MeyOx, 

combusting with a hydrocarbon fuel, CnHm.    

 

Figure 1. Diagram of the CLC concept  

 

 The significant advantage of CLC over conventional combustion is that the use of a metal 

oxide to transport oxygen avoids direct contact between the air and the fuel. This separation 

produces a stream of sequestration-ready CO2, free of N2 dilution, without the major energy 



4 
expenditures of other oxy-fuel reaction methods or traditional carbon separation. Similar to 

traditional energy production, the heat output from the CLC process can be used to expand a 

working fluid through a turbine and run a generator.  

1.3 Selection of an Oxygen Carrier 

The oxidation reaction (3) in the air reactor is always exothermic and produces a heat 

output that can be used for power generation. Depending on the metal oxide used, reaction (2) 

within the fuel reactor may also be exothermic, as with CuO, Mn2O3, and Co3O4, or the reaction 

may be endothermic, as with NiO, Fe2O3, and MoO3. The selection of the oxygen carrier is a key 

aspect of the CLC system’s performance. According to Adánez et al. [3], a suitable oxygen 

carrier for CLC must have a high selectivity towards CO2 and H2O, a suitable oxygen transport 

capacity, a high reactivity for reduction and oxidation reactions, suitable mechanical strength, 

negligible agglomeration (good fluidization), and be environmentally and economically feasible. 

An oxygen carrier is typically composed of a metal oxide that stores and transports oxygen and 

an inert binder to add mechanical strength and increase fluidization. 

Potential metal oxides include Fe, Ni, Cu, Mn, and Co-based molecules, and many 

studies have been conducted to develop these carriers and determine the most suitable for CLC. 

Research by Diego et al. [4] showed the importance of adding an inert binder to the metal oxide 

through significant increases in oxidation rate and maximum conversion rate with the addition of 

an inert binder. A study by Adánez et al. [5] analyzed 240 metal oxide samples consisting of 

different metals, concentrations, and binders for their mechanical strength and reactivity during 

reduction and oxidation. The study determined that Cu-based oxygen carriers (sintered at 950⁰C 
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with SiO2 or TiO2 inerts) and Fe-based carriers (prepared with Al2O3 and ZrO2 inerts) showed 

the best behavior based on reactivity and mechanical strength. The study also determined that as 

the sintering temperature was increased, the reaction rate generally decreased. Through these 

studies, current front runners for CLC metal oxides include CuO, NiO, Co3O4, and Fe2O3 and the 

performance as an oxygen carrier is dependent on factors such as fuel type and reactor 

temperature/type. Ilmenite has also been studied as a more natural oxygen carrier because of its 

low cost and easy access [6]. A study by Cao and Pan [7] determined that among the potential 

metal oxides, Cu, Ni, and Co-based oxygen carriers are optimal for use in solid fuel CLC and 

that among these, Cu-based carriers are the only molecules that reduction is autothermal, 

eliminating the need for external heat in the fuel reactor. From this prior research, copper oxide 

was identified as a well-suited oxygen carrier for solid fuel CLC.  

1.4 Chemical-Looping Combustion for Solid Fuels  

Currently, the majority of studies have focused on CLC for gaseous fuels, including 

synthesis gas derived from coal, however fewer studies have been published on the direct use of 

solid fuels. Development of CLC for solid fuels, especially coal, is desirable because of the 

intensive use of coal as a fuel within energy production and because coal produces significantly 

more emissions than other fuels, such as natural gas. Different methods for utilizing solid fuels in 

CLC have been proposed and studied. Some methods include gasification of the solid fuel either 

before entering the reactor (Syngas-CLC) or inside of the fuel reactor (iG-CLC) [3], [8]–[10]. 

The Syngas-CLC process involves gasifying the solid fuel particles before entering the CLC 

system, creating a syngas fuel to react with the oxygen carrier. In-situ Gasification (iG-CLC) 
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avoids the external gasification by reacting the metal oxide with the fuel gasification products 

directly in the CLC system. However, both of these methods show that the gasification reaction 

is the rate limiting step, which is much slower than the metal oxide reaction, and the reaction 

must occur at high temperatures. Gasification methods also have a high potential for leaving 

unburnt fuel which can exit the fuel reactor and possibly burn in the air reactor, producing 

uncaptured CO2 [8]. Because of these known issues with the gasification CLC methods, it is 

desirable to develop methods that eliminate the need for gasification of the solid fuel.  

One method to eliminate the gasification process is through chemical-looping with 

oxygen uncoupling (CLOU). The CLOU process utilizes metal oxides with oxygen uncoupling 

capabilities that allow them to release gaseous oxygen in the fuel reactor to react with the fuel 

and create an oxygen-fuel combustion, eliminating the need for fuel gasification. Char and 

volatile matter are burnt by oxygen as with conventional combustion, leading to improved fuel 

conversion and higher CO2 capture efficiency in CLOU over iG-CLC [11]. Figure 2 shows a 

schematic of the iG-CLC method compared to the CLOU method where the oxygen carrier 

generates gaseous oxygen which reacts with the fuel char and volatiles. 

 

Figure 2. Schematic of the CLOU process compared to the iG-CLC process for solid fuel CLC [11]. 
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 A study by Mattison et al. [12] showed the feasibility of CLOU with conversion rates a 

factor of 50 higher than gasification CLC methods. The CLOU process requires the use of 

oxygen carriers that can both release gaseous oxygen in the fuel reactor and capture and hold 

oxygen in the air reactor. Copper oxide was identified as a possible metal oxide that meets the 

requirements of CLOU as it can capture and release oxygen in the gas phase through the 

reversible reaction shown in (4). 

 4𝐶𝐶𝐶𝐶𝐶𝐶 ↔ 2𝐶𝐶𝐶𝐶2𝑂𝑂 + 𝑂𝑂2(𝑔𝑔)    ∆𝐻𝐻850 = 263.2𝑘𝑘𝑘𝑘/𝑚𝑚𝑚𝑚𝑚𝑚 𝑂𝑂2 (4) 

 A potential downfall of the CLOU process is that it is designed for high enough temperatures 

(typically above 800⁰C) for the oxygen uncoupling step to occur. The reaction mechanism also 

still contains a limiting gas phase intermediate and other methods propose further simplifying the 

process by reacting the metal oxide directly with the fuel via a solid-solid reaction. Siriwardane 

et al. [13] analyzed the possibility of this reaction mechanism and showed that CuO reacts with 

solid carbon fuel via a “fuel-induced oxygen release” in a solid-solid reaction, avoiding the need 

for gaseous intermediates such as CO and CO2 used in CLOU and other solid fuel processes. Cao 

and Pan [7], [14] examined the overall CLC process with solid fuels and the reaction of CuO 

with coal using a simultaneous thermal analyzer to measure heat flow and mass loss of the 

sample. The thermodynamic analysis indicated that a CO2 concentration above 99% could be 

achieved through a solid-solid CLC reaction. These studies show that it is possible to achieve 

solid fuel CLC without gasification through a solid-solid reaction with carbon fuel and CuO.  
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1.5 Solid-Solid Combustion of C-CuO   

Another study by Siriwardane et al. [15] analyzed the mechanisms of the solid-solid 

reaction between a solid carbon fuel and copper oxide. This study showed that the C/CuO and 

Cu/air reactions take place at lower temperatures (as low as 500⁰C) while maintaining useful 

reaction rates. Contact points between the fuel and the oxidizer particles are critical for the low 

temperature reaction to occur. TGA results showed that CuO reacts with carbon at a significant 

rate around 480⁰C and similarly, CuO combusts with coal char at 779⁰C with an even higher 

reaction rate, as shown in figure 3. Because carbon and char fuels do not produce volatiles when 

heated, this data indicates that volatiles are not necessary for combustion to occur and that 

carbon can react with metal oxides directly.  

 

Figure 3. Reduction reaction performance of CuO with solid fuels [15] 

The two peaks seen in figure 3 for the carbon/N2 line indicate that two combustion 

reactions exist around 480⁰C and 620⁰C and x-ray diffraction (XRD) measurements of the 

carbon-CuO combustion indicated that Cu2O is created as a reaction intermediate at around 
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450⁰C to 500⁰C. Additional measurements of the carbon-CuO reaction using x-ray photoelectron 

spectroscopy (XPS) showed a decrease in the C/Cu atomic ratio and changes in the Cu oxidation 

state from Cu2+ to Cu+ at 440⁰C, confirming that the combustion is initiated by the conversion of 

CuO to Cu2O and then the reaction proceeds until Cu2O is converted into Cu metal. TGA data 

from the combustion of carbon-CuO and carbon-Cu2O confirmed that the first reaction at 480⁰C 

is due to the reduction of CuO to Cu2O and the second reaction is the reduction of Cu2O to 

metallic Cu at 624⁰C, as shown in figure 4.  

 

Figure 4. TGA profile of combustion reaction of carbon with CuO and Cu2O [15] 

Thus, the combustion reaction between carbon fuel and the CuO oxygen carrier consists 

of a two-step reaction mechanism where CuO is first reduced to Cu2O at low temperatures, as 

shown by reaction (5). The Cu2O intermediate is then fully reduced to metallic Cu when higher 

temperatures are reached, as shown by reaction (6). 
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 4𝐶𝐶𝐶𝐶𝐶𝐶 → 2𝐶𝐶𝐶𝐶2𝑂𝑂 + 𝑂𝑂2 (5) 

 𝐶𝐶 + 2𝐶𝐶𝐶𝐶2𝑂𝑂 → 4𝐶𝐶𝐶𝐶 + 𝐶𝐶𝐶𝐶2 (6) 

This combustion reaction mechanism involves “fuel induced oxygen release” through solid-solid 

contact between the carbon fuel and metal oxide. The solid-solid contact is achieved through 

small particle sizes and surface melting, thus contact points between the C and CuO particles are 

critical. The combustion reaction can take place at low temperatures of about 500⁰C if there is 

sufficient contact between the two solids, which is a low temperature that cannot be explained 

through other reaction mechanisms such as fuel gasification or CLOU.  

1.6 Post-Combustion Oxidation of Copper  

Once the copper oxide is reacted with fuel in the combustion reaction, the reduced copper 

product must undergo re-oxidation in the air reactor in order to continue the CLC loop. In the 

case of CuO as an oxygen carrier, the CuO is reduced to metallic Cu through combustion with 

carbon in the fuel reactor, as discussed in section 1.5. The Cu is then passed to the air reactor 

where the Cu is reduced back into CuO to be recirculated to the fuel reactor. Within the air 

reactor, the Cu is oxidized with O2 from the air as shown by reaction (7).  

 
𝐶𝐶𝐶𝐶 +

1
2
𝑂𝑂2 → 𝐶𝐶𝐶𝐶𝐶𝐶 

(7) 

Both the oxidation and reduction reactions for Cu-based oxygen carriers are exothermic, 

meaning that the recirculation between the air and fuel reactors is not affected by heat balance 
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[16]. The exothermic reactions also allow for heat extraction from both reactors for energy 

production. 

 There is currently little literature with a focus on the oxidation reaction of CuO for the 

regeneration stage of chemical-looping combustion. García-Labiano et al. [17] studied the 

reaction kinetics of the reduction and oxidation of CuO supported on alumina created via 

impregnation. Experiments over varying oxygen concentrations and temperatures revealed that 

the oxidation of the reduced Cu-based carrier was controlled by chemical kinetics with an 

activation energy of 15 kJ/mol and a reaction order of 1. Another study conducted by Chuang et 

al. [18] observed the oxidation of Cu by oxygen over temperatures ranging from 300⁰C to 900⁰C. 

The results revealed that the oxidation of Cu can occur directly via Cu to CuO as well as 

indirectly by forming Cu2O as an intermediate.   

 

Figure 5. Final conversion against temperature for oxidation of Cu to CuO at 1.3 vol% O2 [18] 

Measurements of the reaction conversion over varying temperatures, shown in figure 5, revealed 

that below 600⁰C, the oxidation reaction was incomplete, with XRD data detecting a mixture of 

Cu2O, CuO, and some unreacted Cu present within the products. The oxidation shifted to 

complete formation of CuO at temperatures above 600⁰C and was controlled mainly by external 
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mass transfer. This higher temperature oxidation (600⁰C - 900⁰C) was found to occur via an 

indirect reaction mechanism with two consecutive steps, shown by reactions (8) and (9): 

 
2𝐶𝐶𝐶𝐶 +  

1
2
𝑂𝑂2 → 𝐶𝐶𝐶𝐶2𝑂𝑂,    ∆𝐻𝐻1073 𝐾𝐾

0 = −167.3 𝑘𝑘𝑘𝑘/𝑚𝑚𝑚𝑚𝑚𝑚 (8) 

 
𝐶𝐶𝐶𝐶2𝑂𝑂 +  

1
2
𝑂𝑂2 → 2𝐶𝐶𝐶𝐶𝐶𝐶,    ∆𝐻𝐻1073 𝐾𝐾

0 = −131.5 𝑘𝑘𝑘𝑘/𝑚𝑚𝑚𝑚𝑚𝑚     (9) 

Also shown in figure 5, the conversion drops again at 900⁰C. This is because at these 

temperatures, Cu2O is thermodynamically favored and the fully oxidized carrier is decomposed 

to Cu2O and O2. Thus, similar to the two-step reduction reaction, the oxidation of Cu involves an 

intermediate of Cu2O and temperatures between 600⁰C and 900⁰C are optimal in order for Cu to 

completely oxidize to CuO.  

1.7 Research Goal and Objectives 

While chemical-looping combustion has been researched for many years, much remains 

unknown about certain CLC methods and processes. In particular, CLC through solid-solid 

combustion of carbon fuel with a metal oxide shows promise in creating an easier and cheaper 

CLC mechanism, however there is little research behind this topic. Also, all of the 

aforementioned studies utilized an externally heated reactor to examine the metal oxide and fuel 

combustion. However, if a hot-spot is produced in a packed mixture of copper oxide and carbon 

fuel, the reaction may react rapidly and become self-propagating via a combination of solid-solid 

interactions and oxygen uncoupling. The goal of this thesis is to test this self-propagating 

reaction in order to better understand the combustion reaction of solid carbon fuel with copper 
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oxide to evaluate it as a feasible approach to CLC. This goal will be accomplished through the 

following research objectives:  

• Model the combustion reaction using a mixture of solid carbon and copper oxide 

packed into a quartz tube with a furnace supplying an initial temperature. The 

combustion will be initiated by a CO2 laser and recorded on a high-speed camera.  

• Analyze the effect of various experimental parameters on the combustion reaction 

and flame propagation. Parameters will include various preheat temperatures and 

particle sizes. 

• Observe differences between copper oxide oxidation states by testing both CuO 

and Cu2O as metal oxides for the combustion reaction. 

These objectives will lead to a better understanding of the solid fuel reactions in chemical-

looping combustion in order to progress the technology towards industry ready where it can 

begin to improve energy production by reducing harmful carbon dioxide release.  
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Chapter 2  

 
Experimental Methods  

2.1 Copper Oxide Sample Preparation 

As discussed in chapter 1, copper oxide is a leading candidate for many CLC applications 

including CLOU and fuel induced oxygen release methods. For this reason, copper oxide was 

chosen as the focal metal oxide for this study. Multiple variants of copper oxide powders were 

observed including copper(II) oxide (CuO) with micrometer-sized particles and nanometer-sized 

particles as well as copper(I) oxide (Cu2O) micrometer-sized particles. Table 1 shows the 

molecular properties of all metal oxides used in this experiment. All copper oxide powders were 

manufactured and purchased from Sigma-Aldrich chemicals company. 

Table 1. Metal Oxide Properties 

Metal Oxide Empirical 
Formula Particle Size Molecular Wt. 

(g/mol) 
Density 
(g/cm3) 

Copper(II) Oxide 
nanoparticles 

 

CuO <50nm 79.55 6.31 

Copper(II) Oxide 
microparticles 

 

CuO <10µm 79.55 6.31 

Copper(I) Oxide 
microparticles 

Cu2O <7µm 143.09 6.0 

 

The fuel utilized for the combustion reaction was Monarch 120 carbon black powder 

from Cabot with a molecular weight of 12 g/mol, a particle size of 60 nm, and a particle density 

of 1.8 g/cm3. Stoichiometry for CuO was determined through equation (10) which yields a fuel 

to oxidizer ratio (F/O) of 7.54x10-2 on mass basis. Similarly, the stoichiometry for the Cu2O 
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reaction was determined through equation (11), yielding a fuel/oxidizer ratio of 4.19x10-2 on 

mass basis. 

 2𝐶𝐶𝐶𝐶𝐶𝐶 +  𝐶𝐶(𝑠𝑠) → 2𝐶𝐶𝐶𝐶(𝑠𝑠) + 𝐶𝐶𝐶𝐶2     (10) 

 2𝐶𝐶𝐶𝐶2𝑂𝑂 +  𝐶𝐶(𝑠𝑠) → 4𝐶𝐶𝐶𝐶(𝑠𝑠) + 𝐶𝐶𝐶𝐶2 (11) 

The masses of carbon fuel and copper oxide powders to be mixed were calculated through 

equations (12) and (13) respectively using the desired equivalence ratio (ϕ) and batch mass 

(Mtotal) for the experiment.  

  𝑀𝑀𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓 =
𝑀𝑀𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡

1 + 1
𝐹𝐹/𝑂𝑂 ∙ 𝜙𝜙

    (12) 

 
𝑀𝑀𝑜𝑜𝑜𝑜𝑜𝑜𝑜𝑜𝑜𝑜𝑜𝑜𝑜𝑜𝑜𝑜 =

𝑀𝑀𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓

𝐹𝐹/𝑂𝑂 ∙ 𝜙𝜙 
(13) 

Batches were made for a total mass of 2.15g in order to yield two samples of approximately 1g 

each with an extra 0.15g to account for losses occurred while transporting the mixture between 

vials and while loading into testing tubes. All tests in this research were conducted at a 

stoichiometric equivalence ratio of one, meaning that all fuel and oxidizer particles should be 

converted during the combustion. An equivalence ratio of more than one would indicate that 

there is more fuel than oxidizer, which is known as fuel rich, while an equivalence ratio of less 

than one would indicate there is an abundance of oxidizer, known as a fuel lean reaction. 

The copper(I) oxide (Cu2O) powder particles purchased by Sigma-Aldrich were stored 

with a stabilizer coating of 0.5% stearic acid in order to prevent clumping during shipping and 

storage. The stabilizer would interfere with the combustion reaction being tested and additional 

procedures were required to remove the stearic acid coating from the Cu2O particles. Stearic acid 

is soluble in hexane at 0.5g/100g at 20⁰C thus, prior to mixing with the carbon 120 fuel the 



16 
calculated mass of Cu2O for one batch was washed with approximately 5mL of hexane. The 

Cu2O – hexane mixture was shaken and left untouched for at least 30 minutes to allow the stearic 

acid to dissolve and the Cu2O particles to settle. After the 30 minutes, the stearic acid was 

decanted off of the top of the mixture using a pipet, leaving behind the washed Cu2O particles. 

This process was repeated again to assure all of the stearic acid stabilizer was removed and the 

washed Cu2O powder then proceeded to the fuel mixing process identical to the CuO powders.  

The calculated masses of copper oxide and carbon 120 fuel were combined in a glass vial 

with approximately 8-10 mL of hexane to suspend the particles. The vial was then placed under a 

sonicating horn and ultrasonically mixed for 0.5s on and 0.5s off for 1 minute. After sonicating, 

the sample was assumed adequately mixed and was spread out on a stainless-steel pan heated to 

approximately 40⁰C to evaporate the hexane. The dried mixture was passed through a sieve to 

eliminate clumping and bottled until sample testing. Each mixture batch yielded approximately 

2.15g of the CuO/C mixture, which was enough for two 1g samples for the experiment with an 

excess to account for any transportation losses. During sample testing, 1g of the created batch 

mixture was massed out and funneled into a 0.8cm inner diameter quartz tube with a graphite 

plug on one side. The mixture was then packed to a specified length based off of the desired 

density of the packed powder sample.    
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2.2 Combustion Experimental Setup 

The combustion experimental setup consisted of the quartz tube containing the packed 

copper oxide – carbon 120 fuel sample placed inside of a furnace to provide an initial preheat 

temperature ranging from 100⁰C to 450⁰C. A temperature controller with a thermocouple placed 

inside of the furnace directly by the sample was used to regulate the furnace internal temperature. 

Once the sample was properly aligned, the furnace was closed and heated to the desired preheat 

temperature. The sample was allowed to soak at the desired temperature for approximately 10 

minutes to ensure uniform heating. A 70W Synrad CO2 laser was used to ignite a hotspot in the 

mixture from the end opposite of the graphite plug. Once the sample was ignited by the CO2 

laser, the resulting flame propagation was captured on a micro Nikkor camera with a 105mm 

lens using StreamPix 6 recording software. The camera settings used can be seen in table 2.  

Table 2. 105 mm Nikkor and Streampix 6 camera settings.  

Frame Rate F-Stop Pixel Clock Exposure 

59.936 fps 11 86 MHz 9.9836 ms 

 

Experiments where the combustion reaction temperature was monitored utilized a k-type 

thermocouple placed in the center of the sample. A schematic of the experimental setup can be 

seen in figure 6. 
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Figure 6. Schematic of combustion reaction experimental setup 

 

 Images of the experimental setup and equipment as well as images of the raw chemical materials 

used in this research can be found in Appendix A. The experimental standard operating 

proceedures that were followed to conduct testing can be found in Appendix B. 
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Chapter 3  
 

Results and Discussion 

3.1 Influence of Preheat Temperature 

Once a hot spot was ignited with the CO2 laser, the nano-particle CuO/C mixture became 

self-propagating with a luminous flame front travelling down the tube. This flame front was 

captured on the high-speed camera and processed using ImageJ video software where the 

distance the flame travelled between frames could be extracted. The nano-particle CuO/C 

mixture was tested at preheat temperatures ranging from 100⁰C to 450⁰C. Figure 7 shows a 

sequence of frames from the combustion of nano-particle CuO and carbon 120 powder preheated 

to 400⁰C.  

 

Figure 7. Image frames of nano-CuO/C combustion propagation preheated to 400⁰C 
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Figure 7 demonstrates that once a hot-spot was induced with the laser at 0 seconds, the reaction 

became self-propagating towards the end of the tube until it reached the graphite plug. In many 

samples the flame had some inconsistencies, as with figure 7 around 1.5s where the flame is only 

propagating along the bottom of the tube, however it returns to full propagation until completion. 

These inconsistencies could be due to a variety of factors such as non-uniform packing density, 

heating, or mixing caused by limitations in equipment and human error.  

By capturing the propagation frame-by-frame and knowing the frame rate of the camera, 

the time elapsed at each frame could be calculated as frame number divided by frame rate (FPS). 

The flame propagation distance in millimeters was then plotted against the time elapsed in 

seconds and the flame propagation speed in mm/s was found using the slope of a linear fit line of 

the distance versus time plot. Figure 8 shows the distance versus time plot of the same 400⁰C 

preheated sample captured in figure 7.  

 

Figure 8. Distance vs. time plot of nano-CuO/C preheated to 400⁰C 

After the laser ignition, the propagation became very linear with a constant speed throughout the 

sample, which was the case for the majority of samples. However, inconsistent propagation 
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speeds were observed in some of the samples, where the reaction would appear to quench 

partially through the sample and then begin propagation again at a higher speed. This again could 

possibly be due to errors in preparation that cause a non-uniform sample or be caused by varying 

reaction mechanisms, which will be discussed.  

The varying preheating temperatures of the samples showed an influence on the intensity 

and flame shape of the combustion propagation. Samples preheated to temperatures under 

approximately 250⁰C often propagated slower with a less luminous flame front compared to 

samples preheated above 250⁰C. The lower temperature reactions also had a less coherent flame 

front, propagating circumferentially in small spots of the tube rather than linearly across the 

entire diameter of the tube, as with the higher temperature reactions. Figure 9 shows a 

comparison of a sample ignited at 400⁰C against a sample ignited at 150⁰C.  

 

Figure 9. Nano-CuO/C mixture reaction preheated to 400⁰C (a) and preheated to 150⁰C (b) 
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The lower temperature sample in (b) propagated via small pockets of combustion while the 

higher temperature sample in (a) had a luminous and coherent flame front. This propagation 

difference was a common trend, as higher preheat temperatures resulted in coherent flame fronts 

spanning nearly the entire diameter of the tube, while lower temperatures propagated through 

smaller channels and pockets, often leaving portions of the sample unreacted.  

 A possible explanation for this difference is that the changing preheating temperatures 

caused a variation in the primary reaction mechanism. As discussed in chapter 1, oxygen 

uncoupling requires reaction temperatures typically above 800⁰C, therefore the samples 

preheated to lower temperatures may not have reached a high enough reaction temperature to 

create oxygen uncoupling of the copper oxide and thus proceeded only via a solid-solid reaction 

mechanism. Contact points between the fuel and metal oxide particles are critical for the solid-

solid reaction to occur, therefore the reaction only occurred where there was significant contact 

between the fuel and oxide resulting in the observed smaller pockets of combustion rather than a 

coherent flame front. The higher preheated reactions on the other hand may have reached a high 

enough reaction temperature to induce gaseous oxygen release from the copper oxide. The 

oxygen release allowed the combustion to proceed via a combination of solid-solid contact 

reactions as well as fuel reactions with gaseous oxygen. The oxygen uncoupling reaction utilizes 

gaseous oxygen disbursed throughout the tube rather than contact points and therefore created a 

more coherent flame front throughout the tube diameter.  

 Preheating temperature also showed an influence on the propagation speed of the 

combustion reaction. Figure 10 shows a plot of the average propagation flame speed across the 

various preheat temperatures.  
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Figure 10. Propagation speed vs. preheat temperature of nano-particle CuO/C combustion 

Figure 10 reveals a linear trend of higher reaction propagation speeds with increasing preheat 

temperatures. As previously mentioned, samples may have been limited to solid-solid reaction 

mechanisms without oxygen uncoupling assisting the reaction at lower preheat temperatures. 

Previous studies also indicate that the solid-solid reaction occurs at slower rates than other 

mechanisms, specifically CLOU, which may have been a contributor to the slower propagation 

speeds at lower temperatures. The nano-CuO/C mixture was also observed to auto-ignite without 

the use of the ignition laser at temperatures above 450⁰C, indicating this is the temperature 

required to activate the CuO/C combustion reaction.  
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3.2 Influence of Particle Size 

 Two different CuO particle sizes were tested in order to observe the influence of particle 

sizes on the combustion reaction. Reactions of carbon 120 fuel with microparticle CuO powder 

with a particle size of <10µm were compared to reactions using nanoparticle CuO powder with a 

particle size of <50nm. The particle size has a great influence on the bulk density of the sample 

as well as the number of contact points between the fuel and copper oxide. The smaller 

nanoparticles have a greater surface area among them and can create more contact points with 

the fuel. The increased surface area also causes increased friction between particles leading to a 

fluffier powder with a lower bulk density in the nanoparticles compared to the more compact 

samples created with the microparticles. When loading the 1g samples into the quartz tube, the 

larger particle micro-CuO/C mixture had an unpacked length of about 1.5cm, where the nano-

CuO/C mixture had an unpacked length of about 2.2cm. Both samples were packed an additional 

2mm to create a packed sample. Approximating the metal oxide particles to be spheres, the max 

volume fraction for random packing is known to be approximately 64%. Neglecting the mass of 

air in the voids, the theoretical maximum bulk density of the sample is approximately 64% of the 

particle density. The micro-CuO/C mixture was packed to 1.3cm yielding a bulk density of 1.53 

g/cm3, which is approximately 38% of the theoretical maximum density for CuO. The nano-

CuO/C mixture was packed to 2.0cm, yielding a bulk density of 0.995 g/cm3, which is 

approximately 25% of the theoretical maximum.  

 Both particle sizes were tested across the same preheat temperature range of 100⁰C to 

450⁰C. From visual observation of the sample propagation videos, the microparticles propagated 

with a less luminous and less coherent flame front than the nanoparticles. Figure 11 shows a 
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comparison of the nano-CuO/C combustion (a) compared to the micro-CuO/C combustion (b) 

both at a preheat temperature of 400⁰C.  

 

Figure 11. Nano-CuO/C combustion (a) and micro-CuO/C combustion (b) both preheated to 400⁰C 

The nanoparticle combustion flame appeared more luminous than the microparticle reaction. The 

nanoparticle reaction also had a more coherent and consistent flame front, as the microparticle 

combustion was more sporadic and often propagated circumferentially around the tube rather 

than directly forward. The combustion flame of the microparticle reaction also propagated much 

slower than the nanoparticle combustion flame, taking approximately twice as long until full 

propagation. For these two samples, the average flame propagation speed for the nanoparticle 

reaction was 2.54 mm/s while the average propagation speed of the microparticle reaction was 

0.721 mm/s.  This significantly slower propagation speed was a typical trend with the increased 

particle sizes. As shown by figure 12, the microparticle reaction was consistently slower than the 

nanoparticle reaction across all temperatures.  
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Figure 12. Average propagation speed of micro-particle and nano-particle CuO/C 

 The microparticle mixture had larger air voids between the particles creating fewer solid 

contact points between the fuel and copper oxide due to the increased particle volume and 

decreased available surface area. Fewer solid contact points significantly reduced the likelihood 

of a solid-solid reaction because contact points are critical for this mechanism. The microparticle 

reaction may have proceeded through some oxygen uncoupling, but with less assistance from the 

solid-solid reaction than with the nanoparticles. The solid-solid reaction of the nano-CuO/C 

samples at higher preheat temperatures could have worked to increase the reaction temperature 

enough to induce a significant amount of oxygen release from unreacted CuO and create 

combustion via CLOU mechanisms. Thus, it is possible that the reaction mechanisms within the 

nanoparticle samples worked in tandem to create faster propagation speeds. The micro-CuO/C 

samples had less contact points for the solid-solid reaction to proceed, which reduced the amount 

of heat produced through combustion and caused less oxygen to be released by CuO, limiting the 

impact of CLOU mechanisms on the propagation. The microparticle reactions also failed to 

propagate at temperatures below 300⁰C whereas the nanoparticle reactions propagated as low as 

100⁰C. As previously mentioned, CLOU based reactions are likely limited at lower preheat 
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temperatures and the decreased contact points in the microparticles also reduced the impact of 

solid-solid reactions thus, the combustion did not occur with microparticles at low temperatures.  

 The auto-ignition temperature of the micro-CuO/C reaction was consistent with the auto-

ignition temperature of the nano-CuO/C samples at around 450⁰C, indicating that particle size 

does not influence the auto-ignition point. However, during auto-ignition of the nano-CuO/C 

mixture, the sample showed a bright ignition throughout, whereas the micro-CuO/C auto-ignition 

did not give off any significant light and simply propelled itself towards the opening of the tube. 

Figure 13 shows images of the auto-ignited samples of both particle sizes.  

 

Figure 13. Auto-ignited samples of microparticle CuO/C (a) and nanoparticle CuO/C (b) 

The nanoparticle sample in (b) turned the originally black sample to a red-orange color and 

clearly underwent a combustion reaction. However, the microparticle sample in (a) remained the 

black color of the original CuO/C mixture and does not appear to have underwent a significant 

chemical reaction. Gaseous buildup may have caused the ejection of the micro-CuO/C mixture 

during auto-ignition without enough solid-solid interaction to induce combustion.   

From these experiments, the nanoparticle CuO was more reactive across a wider range of 

temperatures compared with the microparticle CuO. The nanoparticles also created higher 
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propagation speeds. It is proposed that the differences in propagation rates and reactivities was 

due to the decrease in contact points between the oxide and fuel particles, which have been 

shown to be critical for solid fuel CLC.  

3.3 Influence of Oxidation State 

As discussed in chapter 1, the reduction reaction for CuO occurs in two steps: first the 

CuO is reduced to Cu2O, shown in equation (14), and then reduced to Cu as shown by equation 

(15). The first reduction to form Cu2O can occur at a lower temperature (around 480⁰C) and the 

second step requires a higher temperature (around 620⁰C) to form Cu. From this reaction 

mechanism, it is shown that the CLC reaction of CuO can produce intermediate products of 

Cu2O if the reaction does not reach a high enough temperature to fully reduce to solid copper.  

 4𝐶𝐶𝐶𝐶𝐶𝐶 → 2𝐶𝐶𝐶𝐶2𝑂𝑂 + 𝑂𝑂2 (14) 

 𝐶𝐶 + 2𝐶𝐶𝐶𝐶2𝑂𝑂 → 4𝐶𝐶𝐶𝐶 + 𝐶𝐶𝐶𝐶2 (15) 

 Visual inspection of the products from the combusted nanoparticle CuO/C samples 

revealed the formation of metallic pockets near the center of the sample where the laser ignition 

had occurred, shown in figure 14 (a). This area is assumed to be the hottest region of reaction 

and thus it is likely that the metallic areas are solid copper formations that had been melted 

together. Outside of the metallic areas, the reaction turned the originally black CuO/C mixture to 

a dark red/brown color, shown through (b) in figure 14.  
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Figure 14. Image of the post combustion products from the CuO/C self-propagation reaction 

Unreacted Cu2O is also known to have a similar dark red/brown coloring, which may indicate 

that the CuO combustion reaction produced Cu2O throughout the majority of the sample. The 

outer edges farther from the ignition point may not have reached a high enough reaction 

temperature to form fully reduced copper. Therefore, it is likely that the self-propagating reaction 

that occurred within the CuO/C mixture did not fully reduce to solid copper, but rather to a 

reaction intermediate of Cu2O with small formations of Cu.  

 To further explore this theory, copper(I) oxide (Cu2O) was used as an oxidizer in place of 

the copper(II) oxide (CuO) to test the effect of using the reaction intermediate at the start of 

combustion. The Cu2O samples were mixed at the same equivalence ratio of one and with the 

same carbon 120 fuel as the CuO samples. The combustion experiments revealed that the Cu2O 

samples did not become self-propagating across the same temperature range as the CuO samples. 

No propagation was observed with Cu2O until a preheat temperature of approximately 425⁰C. 

Even preheat temperatures above 425⁰C did not create significant propagation after ignition, as 

the Cu2O/C reaction propagated slowly and quenched roughly a quarter way through the sample. 

The Cu2O sample was also observed to auto-ignite at approximately 625⁰C, where the sample 



30 
ignited without the laser and quickly ejected towards the front of the tube. The Cu2O auto-

ignition temperature of 625⁰C was much higher than the auto-ignition temperature of 450⁰C 

observed with the CuO/C mixtures. The high temperatures required for the Cu2O reaction 

reinforce the theory that the combustion reactions with CuO stopped at the Cu2O reaction 

intermediate rather than fully reducing to Cu because the CuO reaction did not reach a high 

enough temperature to proceed to the reduction of Cu2O. These observations also coincide with 

findings in other studies discussed in chapter 1 that report the Cu2O to Cu reduction reaction 

occurring at much higher temperatures than the CuO to Cu2O reaction. Cu2O has also been 

shown through other studies to require a higher temperature for gaseous oxygen release through 

oxygen uncoupling. This lack of gaseous oxygen released along with fewer contact points caused 

by the micrometer-sized Cu2O particles could be contributors to the lack of self-propagation 

observed in the Cu2O samples.  

 The auto-ignited samples of Cu2O/C were the only samples believed to have fully 

combusted, as the reactions at preheat temperatures lower than the auto-ignition point of 625⁰C 

were quickly quenched. The auto-ignited samples were observed to change color from the 

unreacted dark red/brown coloring to a lighter, red/orange coloring. Figure 15 shows images of 

the auto-ignited Cu2O/C mixture (a) compared with a Cu2O/C sample heated to a lower 

temperature that quickly quenched upon ignition (b).  



31 

 

Figure 15. Products of Cu2O/C reaction when auto-ignited (a) and when quenched (b) 

The color change is a strong indication that a chemical reaction occurred in the auto-ignited 

sample (a), which was likely the reduction of Cu2O to Cu and the consumption of the carbon fuel 

from the combustion reaction. The quenched reaction in figure 15 (b) did not change in color and 

it was assumed to be unreacted through the majority of the sample. 
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Chapter 4  
 

Conclusion and Future Work 

 Chemical-looping combustion is a promising technology for reducing carbon emissions 

during fossil fuel energy production. Many leading CLC methods currently in practice were 

discussed in chapter 1 of this thesis, however all previous research discussed utilized an 

externally heated reactor to carry out the combustion reaction. This thesis investigated the 

possibility of a self-propagating reaction between a mixture of copper oxide and carbon 120 solid 

fuel initiated by a laser hot-spot. Multiple experimental parameters were varied including preheat 

temperature, metal oxide particle size, and oxidation state of the metal oxide in order to evaluate 

their influence on the combustion reaction.  

 Self-propagating CLC reactions with mixtures of nanoparticle copper(II) oxide powder 

and carbon 120 fuel were observed at preheating temperatures as low as 110⁰C. Increasing the 

preheat temperature created a more luminous and coherent flame front that traveled at faster 

propagation speeds. It was proposed that the lower temperature reactions proceeded primarily 

through a solid-solid reaction mechanism and the increase in flame coherence and propagation 

speeds at higher temperatures was due to the introduction of oxygen uncoupling reaction 

mechanisms to assist with the combustion propagation. The use of larger sized microparticle 

copper(II) oxide powders revealed significantly slower propagation speeds and less coherent 

flame fronts when compared to the nanoparticle combustions. Since contact points between the 

metal oxide and fuel are critical for solid-solid reactions, it was suggested that the difference in 

propagation speed and flame intensity was due to the reduction in contact points created by 



33 
larger particle sizes. Visual observations of the CuO/C combustion reaction products indicated 

that the copper(II) oxide may have been mostly reduced to copper(I) oxide during the self-

propagating reaction, with small deposits of solid copper near the ignition point. Lastly, the 

propagation experiment was conducted using copper(I) oxide as a metal oxide, which revealed a 

much higher auto-ignition temperature as well as shorter and less frequent self-propagating 

reactions. A summary of the important metrics found in this study can be seen in table 3.  

Table 3. Summary of important metrics for different oxidizers 

Metal Oxide Max Speed Propagation Range Auto-Ignition 
Nano-CuO 6.53 mm/s 110⁰C - 450⁰C 450⁰C 

Micro-CuO 1.74 mm/s 300⁰C - 450⁰C 450⁰C 

Micro-Cu2O 1.18 mm/s* 400⁰C - 625⁰C* 625⁰C 

* Cu2O propagations did not travel entire sample length 

 Future work will focus on confirming the proposed reaction mechanisms discussed in this 

thesis. The products formed during all reactions discussed in this research were preserved for 

analysis. These products should be further analyzed in order to identify the molecular content 

and confirm or reject the idea that the CuO reactions reduced primarily to Cu2O and that the 

Cu2O auto-ignited reactions formed Cu. Also, various sample densities, packing methods, and 

mixing methods should be explored since contact points have been identified as a critical factor 

for the solid-solid reaction. Lastly, the post-combustion oxidation reaction was not investigated 

as a part of this thesis and is a topic that is not widely studied in literature. The oxidation reaction 

of copper oxide is also exothermic and may exhibit a self-propagation similar to the combustion 

reactions observed in this thesis. The oxidation reaction should also be explored in future work in 

order to further progress the understanding of chemical-looping combustion methods. 
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Appendix A 

 
Images of Experimental Materials, Equipment, and Setup 

 

Figure 16-A. Images of raw CuO (a), Carbon 120 (b), and Cu2O (c) particles 

 

 

Figure 17-A. Image of combustion reaction experimental setup
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Figure 18-A. Image of camera and open preheating furnace with sample  

 

 

Figure 19-A. Image of sample ignition laser and camera controlling computer 
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Appendix B 

 
Experiment Standard Operating Procedures 

Carbon and Copper(II) Oxide Mixing Procedures 
1. Put on the necessary PPE (Nitrile gloves, Respirator). 
2. Materials: 20mL scintillation vial, particles being mixed, hexane, pipet, 200W hot plate, 

steel pan, aluminum foil, weighing paper, thermocouple, plastic collector, quartz tubing, 
two plungers, graphite plug, scale, sonicator, fume hood, sieve, and brush. 

a. Scales should be cleaned and calibrated every 3 weeks. 
b. Sieve and brush should be cleaned before using different oxidizers/fuels. 

3. Using weighing paper and a scale, measure out the desired amount of oxidizer(s), then 
pour into the vial. 

4. Using weighing paper and a scale, measure out the desired amount of fuel(s), then pour 
into the same vial containing the oxidizer(s). 

5. Pipet hexane into the vial containing the mixture until the hexane is: 
a. A little above half full - 1.1g batch 
b. ¾ full - >2.15g batch. 

6. Apply a small piece of aluminum foil on vial opening and punch a small hole to allow the 
sonicator tip to enter. 

7. Situate the sonicator tip in the center of vial, making sure that the sonicator tip does not 
make contact with any glass surface. 

8. Sonicate the vial for 30 s for 0.5 s on, 0.5 s off, 46% duty-cycle at 450W (1 min total).  
Note: It is normal for the vial to be warm post sonication. 

a. Sonication of a batch size >2.15g may agglomerate and can be identified by a 
high pitch sound, which should  not to be confused with the sonicator tip touching 
the glass. In this situation, sonicate the batch for 30s, 0.2 s on, 0.8 s off, 40% duty 
cycle at 450W. 

9. Wait for 1-2 mins until the vial is at room temperature. 
10. Repeat step 9. Note: This step may be repeated more times depending on how mixed the 

material is by visual inspection. 
11. Place the hot plate under the fume hood. 
12. Place steel pan on the hot plate. 
13. Turn on the hot plate and wait until it is heated to 40°C using the thermocouple. 
14. Turn on the fume hood. 
15. Pour the vial’s contents into the steel pan. Make sure that most, if not all, the vial’s 

contents is poured out. This step may take a couple attempts that require pipeting hexane 
onto the inside walls of the vial to remove clumping, then pouring again. 

16. Wait for 10-20 min. 
17. Using the brush, remove the mixture and pour the powder onto the sieve. 
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18. Using the brush, sieve the mixture into the plastic collector below it. 

a. Use a different plastic collector for different equivalence ratios/mixes. 
19. Pour the sieved mixture out of the plastic collector and into a new vial. 
20. Finally when ready to create a sample, pour and measure the desired amount of the 

mixture using a scale. 
21. On one end insert the graphite plug while holding its position with a plunger. 

a. If using a thermocouple, make sure it is protruting from the graphite plug into the 
sample. 

22. Next pour the measured amount of the mixture into the quartz tubing opposite to the 
plunger/graphite end. 

23. Compress the sample using another plunger to the desired sample length. 
a. If using a thermocouple, pack lightly/slowly. 

Copper(I) Oxide Washing Procedures  
1. Mass out approximately 5 grams of copper(I) oxide and place in a glass vial.  
2. Add approximately 8 ml of hexane to the copper(I) oxide vial. 
3. Shake vigorously or sonicate to mix the metal oxide throughout the hexane. 
4. Let the vial sit undisturbed for at least 30 minutes to allow the copper(I) oxide particles to 

settle to the bottom of the hexane.  
5. After 30 minutes, carefully use a pipet to decant the hexane off of the top.  
6. Add 8 more mL of hexane and repeat steps 2-5 to do a secondary wash.  
7. After the second wash, place the wet copper(I) oxide on a heating pan to evaporate off 

any remaining hexane.  
8. Once dried, brush the copper(I) oxide through a sieve to eliminate clumping. 
9. Store in a glass vial until it is to be mixed following the carbon and copper oxide mixing 

procedures.  

CO2 Laser Operation 
I. PERSONNEL 

1. Experiments operated within a test cell or other confined space require that a 
minimum of 2 personnel be present to permit operation.  Both personnel must be 
trained, and have previously demonstrated their training by participating in a firing 
evolution, while being evaluated by qualified personnel. 

2. Experiments operated external of a test cell or other confined space require only 
one person be present to permit operation, provided the operator has completed all 
lab safety training requirements and has been properly trained to conduct the 
experiments. 

3. Personnel will have completed the EHS laser safety training as well as obtained 
direct training on the specific laser to be used from a qualified operator and 
demonstrated their ability to setup and operate the laser safely. 

II. PERSONAL PROTECTIVE EQUIPMENT (PPE) 
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1. The minimum required personnel protective equipment (PPE) shall be worn at all 

times while the laser power supply is turned ON.  Additional necessary PPE may 
be required depending on materials being used and experiments being conducted.  
These PPE include the following: 

o CO2 laser goggles (required when laser power supply is turned ON). 
o Face Shield or safety glasses. 
o Neoprene (or Neoprene equivalent) chemically resistant gloves. 
o Lab jacket (if necessary). 

III. SPECIFIC LASER INFORMATION 
1. The Synrad CO2 laser is a class IV continuous wave laser.  The power output is 

variable from 0 to approximately 115W.  The beam wavelength is 10.6μm. 
IV. PRE-STARTUP REQUIREMENTS 

1. Alert any personnel in the lab that the laser will be used.  All personnel in the lab 
must either don CO2 laser goggles or exit the lab prior to enabling the water-cooled 
shutter. 

2. Turn ON the “Laser in Use” light outside the laboratory door.  
3. Minimize and/or block potential beam reflections. 
4. Minimize sample size and distance from beam exit to sample location. 

V. LASER STARTUP PROCEDURE 
1. Inspect the beam path – minimize, and if necessary, use the beam dump. Use the 

red guide beam to ensure the path is unobstructed and incident on the target as 
desired. 

2. Initiate water flow to the CO2 laser (2 GPM). Verify no water leaks along line or 
near drain. 

3. Initiate water flow to the shutter/power meter (~1 to 1.2 GPM), if installed. 
4. Plug in the laser at the wall outlet.  The green light on the laser power supply will 

energize. 
5. Turn on the laser power supply (key). Amber light on power supply and laser will 

energize.  
6. Turn on the “tickle” switch (located on the switchbox connected to the Kern 

Electronics laser controller on top of the laser RF power supply) -- the red TICKLE 
light will energize. 

7. When ready to initiate the experiment, ensure the laser switch (on top of the laser 
near the beam exit is ON. The switch is spring loaded so it will have to be held in 
the ON position while firing, otherwise it will turn off. Then turn on the “Laser” 
switch on the switchbox -- the red LASER light on the switchbox will energize and 
fire the laser immediately.  

8. If necessary, adjust the laser output power with the knob on the Kern Electronics 
laser controller.  The power output may be read from the power meter gauge.  Keep 
the water-cooled shutter disabled (closed) during this process. 
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VI. LASER SHUTDOWN PROCEDURE 

1. Turn OFF the laser (switch over the beam exit). 
2. Close the water-cooled shutter via the shutter control module.   
3. Turn OFF the “tickle” and “laser” switches. 
4. Turn OFF the laser power supply (key). 
5. Unplug the laser power supply from the wall outlet. 
6. Shutoff shutter/power meter and CO2 laser water supplies (once the system has 

been allowed to cool). 
7. Turn OFF red guide beam. 
8. Turn OFF power strip.  
9. Turn OFF the “Laser in Use” light outside the laboratory door.  

 
Combustion Experiment Procedures 

1. Setup the sample and prepare the sample ignition experiment: alignment, oven temp, 
sample in the center view of the camera, wooden block upright, copper block between 
oven, TC below sample. 

2. Take a calibration shot with camera and scale for each new day of testing or if camera 
position/settings are changed. 

3. Close the furnace and set to the desired preheat temperature. Once the sample has 
reached desired temperature, allow the sample to soak for 10 min, or until the internal 
sample TC is at the desired temperature. 

4. Put on CO2 safety glasses/goggles. 
5. Start-up laser following the laser SOP. 
6. Ensure the proper camera settings (Hold is checked on Sampling Rate and Exposure). 

Open a new sequence in the camera software.  
7. Switch both the front shutter switch, near the front of the laser, and the tickle switch to 

their ON positions. 
8. Start the camera by pressing record and DAQ recording BEFORE lasing. 
9. While holding the front shutter switch in its ON position, turn the laser control switch ON 

to fire.  
10. Release the front shutter switch when ignition is achieved, then turn shutter, tickle, and 

laser to their OFF positions. Shut down the laser following the laser SOP. 
11. Stop the recording AFTER the burn is complete and verify the camera data file was 

properly saved as a JPEG Quality 95. Export the full sequence to an avi file.  
12. Mention any particular comments about the run. 

Data Processing Procedure  
1. Follow relevant mixing, laser operation, and testing procedures to capture reaction video.  
2. Use a USB drive to move the video from the lab testing computer to the work PC with 

network connection. 
3. Record batch and sample parameters in Batch to Checkout.&.Sample Information Excel 

sheet.  
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4. Record sample and test parameters in Testing Summary Excel sheet. 
5. Open the video file in ImageJ as a “Virtual Stack”. 
6. Trim the video to only ignition and flame propagation by using Image->Stacks->Tools-

>Slice Remover. Save the trimmed video in the Video shared folder.  
7. Open the calibration image in ImageJ to determine the pixel/distance ratio. Set the ratio 

for the video file under Analyze->Set Scale. 
8. Go to Analyze->Set Measurements and check only Centroid and Stack Position.  
9. Use the Wand Tracing Tool to select the front center of the flame propagation wave. 

Press CTRL+M to take a measurement. Continue taking propagation measurements 
approximately every 10-20 frames until the end of the propagation.  

10. In the measurement window, save the measurement data as a csv in the project folder.  
11. Open Kaleidagraph and paste the measurement data into the data window. 
12. Calculate the time at each frame in the formula window using the camera Frame Rate. 

a. Time = Frame/Frame Rate 
13. Plot the x-position with respect to time using Gallery->Linear->Scatter.  
14. Fit a line to the scatter with Curve Fit->Linear. The equation of the line appears at the top 

of the graph and the slope is the flame propagation speed. Record the propagation speed 
on the Testing Summary sheet. 

15. Save the sample Kaleidagraph graph in the QPC Sample Plots folder.  
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